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From The Chief Editor's Desk
Even though I was just shy of nine years old, I can remember it like it was yesterday. I'm sure many of you remember it, too.
I'm talking about the first landing of man on the moon.
July 20, 1969 at 20:17 UTC, the world saw the first two human beings land on a celestial body that wasn't Earth. They landed with about 50 seconds of fuel remaining.
"Houston, Tranquility Base here. The Eagle has landed," said mission commander Neil Armstrong. The change of call signs from Eagle to Tranquility Base signified that the landing had been successfully completed.
On July 21, 1969 at 02:56 UTC, the world saw those same two human beings take their first steps on a celestial body that wasn't Earth.
As an eight-almost-nine year old, I remember being allowed to stay up late to watch this historic event. Estimates of between 500 million people and 650 million people from around the world watched live as Neil Armstrong descended the ladder from the lunar module. The actual number varies, depending on your reference source
With that first step on the lunar surface, Armstrong spoke his immortal words. "That's one small step for [a] man, one giant leap for mankind." Buzz Aldrin joined Armstrong 19 minutes later, as the second human to walk on the moon. His words to describe his view on the surface of the moon were simple and succinct, but strong. He uttered two words: "Magnificent desolation." The two conducted and completed experiments on the surface of the moon during the 2.5 hour lunar EVA.
They gathered up 47.5 lbs (21.55 Kg) of samples of lunar rocks and soil during their activities on the lunar surface. After returning to the lunar module, they did some housekeeping and got seven hours of sleep. Upon awakening, they launched from the lunar surface to rendezvous with the command module, Columbia, piloted by Michael Collins and in lunar orbit.
The three successfully returned to Earth on July 24, 1969.
That was 50 years ago. It's not hard to find accurate accounts of the feat on the web. Wikipedia has a pretty thorough entry about it, as well.
What's especially sad is that we have had whole generations of people who have not experienced another human traveling to and walking on another world. We have generations of people who have never seen humans leave low-Earth orbit. They have not gotten the thrill of seeing humans expand their horizons and push the boundaries of what can be accomplished. For them, humans walking on the moon is about as real as the story in any Arthur C. Clarke science fiction novel.
Hopefully, this should all change soon. President Donald Trump (it doesn't matter if you like him or not, or what you think of him) and Vice-President Mike Pence have set an ambitious goal of returning humans to the moon by 2024. That's only five years away. This time, the goal is to return to the moon to stay.
Back in the days of Apollo 11, computers were still in their infancy. Your old flip style cell phone has/had more computing power than the onboard computers of the spacecraft of that era. Heck, the first IBM PC wouldn't be released for another 12 years.
More than likely, Linux will play a role in returning humans to manned spaceflight, and in our voyage to our celestial neighbors. It was reported a few years ago that a custom version of Debian has already replaced the Windows XP based computers on the International Space Station to provide better reliability. Many other systems on the ISS already run RedHat Linux and Scientific Linux. NASA has long embraced free and open source software. Elon Musk has tweeted that Dragon's code is written in C++ on Linux. Search for "linux and space travel" and see for yourself.
There is no doubt that Linux will play an important role in returning humans to space, blazing the way to historic endeavors, like putting humans on Mars. What's even better, my kids will experience the thrill that I experienced as a kid of seeing humans walking on our nearby celestial neighbors. Plus, all of those previous generations around the world will also share in that thrill, the one that they missed out on when we switched to only going into low-Earth orbit.
Yes, it's exciting times, to be sure.
Until next month, I bid you peace, happiness, serenity and prosperity.
Cutting The Cord In 2019
by Paul Arnote (parnote)
Over the past several years, "cord cutting" when it comes to cable or satellite TV has become quite popular. With cable TV, subscribers are getting fed up with a pretty much all-or-none subscription plan, forced to pay for channels they don't watch and have no interest in. It's a similar situation for satellite TV customers, too. In my neck of the woods, the typical cable bill runs somewhere between $100 and $200 per month (but that includes cable TV, high speed internet, and a VoIP landline phone connection).
The companies that run cable and satellite TV services make obscene profits, and the prices for the services keep going up and up, year after year. Nationwide, the average cable bill is $107 per month (2018 data), and the cost for cable television has gone up 50 percent since 2010. It's enough to make any reasonable person wonder if the prices keep going up each year (or is at least one of the reasons) as more and more customers cut the cord, and the companies keep raising the prices to meet projected earnings. In the end, only the stockholders of those companies are kept happy, while the customers keep fleeing the ever increasing prices and fleecing.
There are many paid options, and most people are very familiar with them. Streaming services, such as Hulu, Netflix, Amazon Prime, Sling and others offer popular alternatives to cable or satellite TV. But these cost money that many don't want -- or can't afford -- to pay.
In the end, paying for two or three of these streaming services is still cheaper than paying for the most basic cable or satellite plans out there. Plus, you get the option of viewing the programming you want, when you want, on YOUR schedule. You'll likely see significant savings, as well. For example, subscribing to just Hulu and Netflix will cost you about $200 a year. That sure beats the $200 a month you'll spend on some cable plans!
By all means, if you are an Amazon Prime member (I am not, but I know a lot of people are to take advantage of the free two-day shipping), take advantage of the free access to Amazon Prime Video. No one would blame you. It's Amazon's streaming service that comes as a "perk" for being an Amazon Prime member.
But, what's a person to do when they want to NOT have to pay for television programming content? Fortunately, there are several options. This is what I plan to explore here. There's another way to accomplish this, without having to install Kodi or MythTV. It will involve a little more work than sitting back in your recliner and changing the channel on your cable or satellite box, but it is doable. And, it isn't that difficult.
Let me preface all of this by stating that the services are not listed in any particular order. You'll also probably have more success if you are willing to be a bit more flexible with your browser choices. I'm a diehard Firefox user, and I really hate to fire up Google Chrome (but this article isn't about all of the reasons I really dislike Google Chrome, so we won't even go into any of that). However, some of these services won't play in Firefox, but end up playing exceptionally well in Google Chrome. Many of these services play well in either browser. If you're planning on "casting" your streaming media to a Google Chromecast, then Google Chrome will be pretty much a requirement.
We'll focus mainly on services that will play well on your desktop or laptop computer. Some services are designed primarily for viewing on mobile platforms (like Android or iOS), and desktop/laptop users find it a struggle to view them, if at all. Some services will require you to sign up for an account, while others will allow you to watch programming with or without an account.
Finally, you may want to use a VPN. In fact, it may be necessary, like when you're trying to view BBC programming but you're not in Europe. At the very least, you may want to anonymize your viewing activity to some degree, and a VPN could very well help you do just that.
OTA
If you cut the cord to your cable or satellite service, you will most likely want to receive the programming of your local channels. You will most likely want to at least receive the local news, weather and sports reports. If you're watching on your TV set, all of this can be achieved by receiving OTA (over the air) channels via an antenna setup. But if you're wanting to stream local programming, don't despair. For local news, weather and sports, it's as easy as connecting to your local broadcaster's website. Where I live, you can stream entire newscasts, as well as pick and choose which news stories you are interested in viewing, from no fewer than four different broadcasters.
Plus, you're not restricted to local news from just your area. Let's say you live in Bangor, Maine. You have family that lives in Atlanta, Georgia. You're planning a visit in three weeks to see them. You can pull up the local newscasts from the Atlanta broadcasters to stream on your computer.
Being able to stream local independent stations may be a rather hit-or-miss proposition. But if the local station you want to stream is affiliated with a major network, you can also pull up the website for that major network to stream shows from their programming lineup. ABC, CBS, NBC, FOX and PBS (you will have to provide your ZIP code for the PBS site) are the major over the air broadcast networks in the U.S., and you can stream their programming on your computer with relative ease. It's pretty much the same with the minor broadcast networks, like The CW (and don't skip the sub-site CW Seed, where you'll find some rather unique programming, like animated shows from DC Comics). The exception here is CBS. It isn't clear which items are free to stream, and which items require CBS All Access, CBS's paid streaming service that offers such programming as Star Trek: Discovery and the new, upcoming Star Trek series, Picard. They seem to spend an inordinate amount of time and effort to get you to sign up for a CBS All Access account.
Cable Channels
Just because you give up your cable or satellite service provider, that doesn't mean that you also have to give up your favorite cable/satellite access only programming choices. Most of the cable network providers also have the ability to stream their programming directly on their website(s).
Some, like AMC and History, have limited free offerings without signing in through a cable provider. This isn't unusual to find, so don't be too disappointed. They don't always make it easy for cord cutters to access their programming for free, and I suspect it has something to do with deals made with cable and satellite service providers. Even though you may be locked out one time, it's worth going back again and again. Periodically, they unlock content that you might want to watch. Keep in mind that if you see a little padlock or key, or if you don't see the words "Free Episode" next to a description, you will most likely have to sign in with the credentials for your cable or satellite service provider to view that content.
One thing to be on the lookout for is a button (usually somewhere at the top of the page) that says "Watch Live" or "Live Streaming." This will sometimes allow you to watch the programming that the networks are currently airing. Other times, it will lead to a page containing the live feed, asking you to log in with your cable or satellite service provider before allowing you to watch. It's another trip to the craps table at the casino.
While searching out programming choices, you're likely to be surprised about whom owns who. AMC Networks, for example, include AMC, BBC America, IFC, and Sundance, among others. NBC owns USA, Syfy, Telemundo, E!, Universal Kids and Oxygen. The Discovery Networks include such programming choices as Animal Planet, American Heroes Channel, TLC, Science Channel, DIY, and several others. I think you get the idea.
And just because, for example, AHC (American Heroes Channel) is owned by Discovery, don't expect that because a lot of stuff is "locked" content on Discovery that things will be the same on AHC. Another good example is on IFC. On the "mothership" site, AMC, a lot of content is "locked" and requires logging in with your cable or satellite service provider to view. However, on the IFC site, this is not necessarily so, as there is a significantly higher percentage of "unlocked" programs on the IFC site than on the AMC site.
On many of the "cable channel" sites, the extras and trailers are usually free to watch. Don't overlook them, as they can be quite informative and entertaining. While the Discovery Channel seems to be locked up tighter than Fort Knox, most (if not all) of the "extras" are free to view without logging in through your cable or satellite service provider.
The cable news channels (Fox News, CNN, MSNBC, etc.) almost always have plenty of news content. Usually, you can either watch live, or hand-pick which news stories you want to watch. The same goes for cable channels that present the weather, like The Weather Channel.
You can keep the kids entertained with not only wholesome and educational shows from PBS and PBS Kids, but you can also stream unlocked episodes of animated kid-friendly programming from the Cartoon Network.
Here's something I found to be odd. WGN America is carried on just about every cable and satellite service provider's lineup available in the U.S. This is the broadcast that is sent out to the rest of the country. There is a WGN-9 in Chicago, and that broadcast used to be sent out to cable and satellite service providers everywhere. On it, you could watch Cubs games, watch the 9 p.m. news, and everything else, just like everyone else in Chicago. But WGN America doesn't broadcast Cubs games, or anything else that's "Chicago-centric." Instead, it's a lineup of mostly heavily recycled reruns. Oddly, there is no provision on the WGN America site to live stream that channel. But, you can live stream the local Chicago feed from WGN-9. The Cubs games are blacked out on the live stream of the local WGN-9, for those looking to catch a Cubs game ... or two ... or three ... or more.
Don't expect to find any of the programming from the premium cable channels lurking out there for free. HBO, Cinemax, Showtime, Starz, The Movie Channel, The Disney Channel, etc. all have their own streaming services that are available for a monthly subscription. You might be able to sign up for a free trial, but be certain that you cancel your subscription before the trial period is up. Otherwise, you'll end up with an unexpected charge.
With everybody and their brother starting up new subscription model streaming services, subscribing to them all will cost you more than a monthly cable subscription. Most streaming services want between $5 and $10 a month just to stream their programming. This can add up very quickly, which is why I've spent most of my time focusing on free streaming services.
Internet Only Streamers
Luckily for most cord cutters, you have some additional resources for streaming your television programming. These are services you'll probably rarely (if ever) see on your cable or satellite service provider's channel lineup.
This is also where things get most interesting for cord cutters. These internet only streaming services offer a wide selection of movies and television shows. Are you going to have access to the latest, most recent movies or television shows? Nope. But if you can't find something there to watch -- or re-watch -- then there is probably something wrong with you.
Before anyone says anything, I left one popular service off the list. That service is Sony Crackle. I cannot get it to play on PCLinuxOS, in any browser I've tried. So, if it won't play on PCLinuxOS, it gets omitted. There are a lot of people who praise Crackle online, so consider that to be yet another possibility if you are streaming on a mobile device.
Vudu not only has a healthy selection of movies, but it also has a healthy selection of television shows. Granted, most of the free offerings are older, having come out quite a few years ago. Still, there's a good chance you'll find something to watch. Maybe it was a movie that you always intended to see, but for some reason never did. Maybe it's a movie you want to watch again. The free movies are supported by periodic ads. Ad-free versions of the movies and newer movies are available, for a price. You will also need to sign up for an account. Vudu will not playback programming content in Firefox, so you'll have to use Google Chrome to view the content.
Vudu is also home to all the digital copies you see touted on DVDs and BluRays sold at Walmart and other retailers. Redeem the code for the digital copy that is enclosed with your qualifying DVD or BluRay disc (usually on some piece of paper inserted into the disc packaging), and you'll be able to access those movies from wherever you may happen to be, as long as you have an internet connection. My new Vizio Smart TV has connected access to Vudu, and many other smart TVs do as well. It makes it extra convenient to pull up the list of movies and play them on the TV. Plus, those movies that you own a digital copy of are shown in high-definition, without any ads. We covered Vudu in the January 2019 issue of The PCLinuxOS Magazine.
Tubi is another streaming service that we have previously covered in The PCLinuxOS Magazine, back in the May, 2016 issue. With Tubi, you get access to thousands of titles, ranging from movies to television shows. You can search for titles by name or genre. Just like with Vudu, most of the available titles are a few years old, but there is a very wide variety of titles available. Tubi plays fine in either Firefox or Google Chrome.
Retrovision Classic Movies might be your destination if you really like older, classic movies and TV shows. Browsing through their offerings, I saw one movie from 1925 (Phantom of the Opera). They have a wide variety of television shows from the 1950s and 1960s, as well as a lot of movies mostly from the 1930s through the 1950s. I did see a smattering of movies from the 1970s and 1980s, though. There are the first five episodes of the Beverly Hillbillies, quite a few Ozzie &Harriet episodes, and even some old Popeye cartoons for the kids. Retrovision Classic Movies plays equally well in either Firefox or Google Chrome.
Popcornflix is another free streaming site that has tons of movies (including the first three Star Trek movies), and features about 100 different TV series. The movies are sorted by genre, including a "Staff Picks" section containing a collection of the highest rated movies and TV shows. You don't even have to sign up. Just visit and start viewing your selections! Popcornflix plays just fine in either Firefox or Google Chrome.
Pluto TV is a free streaming site with a guide that resembles the guide on many of cable and satellite services. They feature a collection of movies and television shows. You should be able to easily find something to watch amongst its offerings. Do expect the programming to experience slight interruptions for advertising, but it isn't extreme. Look at it this way: your programming on cable and satellite is also interrupted by advertising, and you pay for that! I first learned about Pluto TV when I was exploring my new smart TV, which had a built in app for it. The only downside is that you have to watch the programs when they are aired. There is no time shifting. Pluto TV plays well in either Firefox or Google Chrome.
XUMO is another free streaming site that is very similar to Pluto TV. It has a guide presentation of the programs that are currently playing. But what's different about XUMO is that it also has an On-Demand section. There is no need to sign up, sign in, or create an account. Just visit their website and start streaming! Here is a tip, though. You will be unable to view the XUMO guide unless you make the web page full. On my Xfce desktop with Firefox, I do that by pressing F11. XUMO plays very well in either Firefox or Google Chrome.
SnagFilms is a streaming site that I can best describe as eclectic. Browsing through its offerings, I recognized few films in the catalog. Still, there were several that caught my eye as potentially interesting. SnagFilms plays well in either Firefox or Google Chrome.
The Internet Archive has a whole collection of movies and TV shows that you can stream. Some of the titles in the collection are reminiscent of the titles that they used to make fun of on MST3K, like "The Brain That Wouldn't Die." But there are also some real gems in there too, like Vincent Price's performance in "The Last Man On Earth," based on the SciFi novel "I Am Legend." The site runs equally well in either Firefox or Google Chrome.
It might not seem obvious at first, but YouTube also offers a ton of free movies. Pull up YouTube, go to the list on the left side of your browser window, scroll down to "More From YouTube," and select "Movies & Shows." The first category that is displayed should be "Free With Ads." There is a healthy selection of quality movies available for streaming. Similarly, you can find hundreds (if not thousands) of lesser known movies by typing "free movies" into the YouTube search bar.
Use Your Card
No ... not your credit or debit card. Use your library card, you silly goose! Many libraries allow you to electronically check out movies and documentaries, as well as ebooks, audiobooks, and music. If your library participates, you can typically "check out" programming using your library card, and you have three days to watch movies or documentaries. Here's the sweet part of the deal: in most locales, you can sign up for a public library card ... for FREE!
Hoopla is one such service that partners with participating libraries to allow you to do just that. I'm unable to locate a list of participating libraries on the Hoopla website. But, you can browse their list of movies here. OverDrive is another service that does the same thing. It has functionality to see if your local library participates. Just go here, and enter your zip code to see if your local library is listed. Kanopy is a third such service, with nearly 5,000 movie titles available to choose from. Just enter your local library (or university) name in the search box to see if your local library or university participates.
Summary
If you are serious about "cutting the cord" to your cable or satellite service provider, it's becoming easier and easier to rid yourself of the overpriced, onerous cable bills. Even more, it's becoming quite easy to replace your cable or satellite service provider with FREE streaming options. While you might not be able to access the latest, greatest programming choices by using the free services, it's unlikely that you'll have much difficulty watching something that YOU want to watch, WHEN you want to watch it.
If you're willing to pay the much more modest fees for the subscription streaming services, then you'll also gain access to much more recent programming content.
These are choices that weren't generally available even five years ago. Linux users are accustomed to having choices. Isn't it nice to have choices?
Inkscape Tutorial: Rubber Stamp
by Meemaw
I saw this the other day! It's a quick and easy way to create text that looks like it was made with a rubber stamp.
Create your page, then draw a circle (remember, to keep your circle perfectly round, you should press the <Ctrl> key while you draw). Duplicate the circle and make the duplicate a bit smaller. Also, make the Stroke size a bit bigger for the inner circle.
Now create your text using the Text tool. Format it however you want, then place it in the center of the circles. You can use Align and Distribute to center everything.
Make sure all items are paths (for text, choose Path > Object to Path and for circles choose Path > Stroke to Path). Select all, then choose Path > Union.
With the Calligraphic tool, draw randomly over the figure, covering nearly all of it. Select all and choose Path > Intersection. As you can see, the part covered with the Calligraphic tool is the part that’s visible afterwards.
Change the color to whatever you want, then apply a slight Gradient to it. For a more natural look, you can add a bit of Gaussian Blur.
ms_meme's Nook: Texstar Has High Hopes
PCLinuxOS Recipe Corner
Grilled Italian Chicken
Ingredients:
4 boneless skinless chicken breasts (about 1 1/4 lb)
1 medium yellow bell pepper, cut into 4 wedges
4 plum (Roma) tomatoes, cut in half
1 small red onion, cut into 8 wedges
1/2 cup reduced-fat Italian dressing
Directions:
1. Heat gas or charcoal grill. Cut 4 (18x12-inch) sheets of heavy-duty foil. Place 1 chicken breast, 1 bell pepper wedge, 2 tomato halves and 2 onion wedges on center of each sheet. Pour 2 tablespoons of the Italian dressing over chicken and vegetable mixture on each packet.
2. For each packet, bring up 2 sides of foil over chicken and vegetables so edges meet. Seal edges, making tight 1/2-inch fold; fold again, allowing space for heat circulation and expansion. Fold other sides to seal.
3. Place packets on grill over medium heat. Cover grill; cook 18 to 22 minutes, rotating packets 1/2 turn after 10 minutes, until juice of chicken is clear when center of thickest part is cut (170F). Place packets on plates. Cut large X across tops of packets; carefully fold back foil.
Serves 4
Options:
Individual grill packets are super quick to assemble and very easy to pop on the grill for cooking. For a "no-dishwashing-required" meal, serve the packets on sturdy disposable plates.
Serve these easy packets with a crisp green salad and cantaloupe wedges.
De-Googling Yourself, Part 4
by Alessandro Ebersol (Agent Smith)
In the previous articles, I discussed how Google was born, how it watches over its users, how it harms both individuals and businesses, and now we will begin to see how to protect ourselves from Google.
Alternatives to Google
To effectively reduce Google's meddling in our lives, we must reduce its use.
There is one catch, however. Google, which was coincidentally born when the commercial Internet began to establish itself as a popular mass media and file exchange, unfortunately, is so ingrained in the internet itself that to have it completely removed from the users' lives can be an impossible task.
But we can diminish its presence and gradually undermine its influence on our lives to the point where Google will be irrelevant.
So let's see what Google's alternative services and products exist, and how we can slowly go down that road.
And, as Google started with a search service, there's nothing better than starting with alternatives to Google Search.
Google Search
Google not only tracks your searches, but where you go online, what you write in your emails, who you send them to, and more. Its business model consists of profiling its users and profiting from it. It's much worse than being followed by a private detective.
You cannot predict who will have this information in 20 years and how it might be used. We already know that intelligence agencies are asking companies like Google and Yahoo to give this information to them. This applies to people who use Google, Yahoo, Bing, even if they don't live in the U.S. Thus, using Google search is a cumulatively dangerous act.
Alternatives to Google Search
DuckDuckGo
DuckDuckGo (DDG) is an Internet search engine that emphasizes the protection of the privacy of its users and avoiding the filter bubble of custom search results. DuckDuckGo distinguishes itself from other search engines by not ranking its users, and showing all users the same search results for a given search term. It prioritizes the return of the best results, rather than more results by generating these search results from more than 400 sources, including crowd sourced sites like Wikipedia, and other search engines like Bing, Yahoo! and Yandex. As of June 2019, it had an average of 39,107,576 daily direct searches.
The company is headquartered in Paoli, Pennsylvania, Philadelphia, and has 67 employees as of July 2019. The company name is a reference to the duck, duck, goose children's game.
Some of DuckDuckGo's source code is open source hosted on GitHub under the Apache 2.0 license, but the core is proprietary. The company registered the domain name ddg.gg on February 22, 2011, and acquired duck.com on December 12, 2018, which is used as shortened URL alias that redirects to duckduckgo.com.
DuckDuckGo positions itself as a search engine that puts privacy first, and as such, does not store IP addresses, record user information, and uses cookies only when necessary. DuckDuckGo creator Gabriel Weinberg states: "By default, DuckDuckGo does not collect or share personal information. That's our privacy policy in a nutshell." However, they keep records of all search terms used.
Qwant
Qwant is a French web search engine, launched in July 2013 and operated in Paris. It claims not to employ user tracking and does not customize search results to avoid capturing users in a filter bubble. It is available in 13 languages.
The site handles more than 10 million search requests per day and more than 50 million users per month worldwide, spread across its three main entry points: the normal homepage, the lightweight version, and the "Qwant Junior" for kids, with filtered results.
In the development phase, Qwant searches were powered by Bing, in addition to its own indexing capabilities. Qwant also confirmed the use of Bing's advertising network. As of March 2019, Qwant is the 41st most visited website in France, and the 879th most visited website in the World.
According to its founder, Qwant doesn't want to compete with Google, but prefers to "show something different." Users can create a free account, which allows them to post to "boards", a feature with functions similar to those of a social bookmarking platform. Previous prominent features, such as a Wikipedia-based Knowledge Chart (called the Qnowledge Graph), appear to have been discontinued.
In July 2016, Mozilla signed a contract with Qwant to allow them to distribute an officially sanctioned version of the Firefox browser with Qwant as the default search engine. Qwant currently has a Firefox browser based on the Apple App Store available for iOS.
When it was launched in 2017, the Brave web browser introduced Qwant as one of its default search engines.
The French government in 2018 decreed that all government searches would be done using Qwant.
In June 2019, Qwant launched Qwant Maps, an open source mapping service that uses the OpenStreetMap database to deliver privacy while respecting maps and routing. He also unveiled Masq by Qwant, an open source technology that enables online services to deliver personalized results from data stored securely on a user's device.
The namesake company behind the search engine was co-founded in February 2011 by Jean-Manuel Rozan, a financier; Eric Leandri, a computer security expert; and Patrick Constant, a search engine expert. It employs more than 160 people, spread across five French cities (Paris, Nice, Ajaccio, Rouen, Epinal) and has offices in Germany and Italy. The company claims it makes money through commissions it receives when users visit advertised sites like eBay and Tripadvisor from their search results.
Startpage
Startpage is a web search engine that highlights privacy as a distinguishing feature. It was formerly known as the Ixquick meta search engine, with Startpage being a variant service. Both sites were merged in 2016.
Ixquick was founded by David Bodnick in 1998 and belongs to the Netherlands-based Startpage BV since it acquired the Internet company in 2000. Ixquick and its sister project Startpage.com reached their last daily direct query record (28 days average) of 5.7 million as of February 2, 2015.
The company also provides the standalone proxy service, Startpage.com Proxy, which is incorporated into the Startpage search engine, allowing users the option to open all search results through proxy. The company has also developed a privacy protection service called StartMail. This service was launched to the public in 2014.
How Startpage Search Works
You can't beat Google when it comes to online searches. Then Startpage pays to use the brilliant search results from Google, and removes all trackers and records. The result: the best and most private search engine in the world.
No personal data store,
Startpage does not collect or share your personal information. Ever. There is literally no user data on the company's servers. The company does not profile the user, and cannot be forced to surrender its data to the authorities simply because it has no data to deliver.
Incognito
Clicking search results means leaving the protection of Startpage.com. This can lead to a cookie truck being installed on your device. For this reason, the company developed the "Anonymous Viewing" feature. With "Incognito", users can visit search results in complete privacy and keep browsing. They'll never know they were there. The resource can be found next to all search results.
No filter bubble
Other search engines use search habits to deliver results that they think the user wants, basically trapping users in a result chamber. With Startpage.com, the filter bubble is broken for a wider range of results.
Ecosia
Ecosia is a Berlin-based Internet search engine that plants trees by donating 80% or more of their surplus income to non-profit organizations that focus on reforestation and conservationism. Ecosia considers itself a social business, is CO2 negative, claims to support full financial transparency, protects the privacy of its users and is certified by B-Lab as a charitable corporation.
The site maintains a running total of the number of trees planted. According to its website, as of July 16, 2019, the search engine was responsible for planting more than 62 million trees. Its online shopping and search advertising revenue is donated to a reforestation program, currently in Burkina Faso. In November 2015, Ecosia celebrated 3 million planted trees and US$ 5 million donated to the environment. Ecosia is also available on mobile devices, one can find the app on the Google Play Store or iOS App Store.
The search engine at launch originally provided a combination of Yahoo! and technologies from Bing and Wikipedia. Ads were delivered by Yahoo! as part of a revenue sharing agreement with Ecosia.
Ecosia search results are now provided by Microsoft Bing, enhanced by the company's own algorithms. It is currently available as a web browser or mobile app on Android and iOS devices.
By 2018, Ecosia pledged to become a privacy-friendly search engine. Searches are encrypted, not stored permanently, and data is not sold to third party advertisers. The company states in its privacy policy that it does not create personal profiles based on search history, or use external tracking tools such as Google Analytics.
Ecosia displays ads alongside its search results and is paid by partners whenever a user is directed to an advertiser via a sponsored link. A single survey in Ecosia generates on average about half a cent (0.005 EUR). Ecosia takes Ecosia 0.22 euro (€) and 1.1 seconds to plant a tree.
Ecosia was first launched on December 7, 2009 to coincide with the UN climate negotiations in Copenhagen. Over time, Ecosia has supported various tree planting programs. Until December 2010, Ecosia funds went to a WWF Germany program that protected the Juruena National Park in the Amazon basin. To protect this area, organizers drafted and funded plans with logging companies and local communities.
By 2011, the search engine had raised over €250,000. In 2013, about 200,000 people were using Ecosia and 116,000 seedlings were funded by donations from Ecosia.
YaCy
YaCy (pronounced "ya see") is a free distributed search engine based on peer-to-peer (P2P) networking principles. Its core is a computer program written in Java distributed on several hundred computers, as of September 2006, called YaCy-peers. Each YaCy-peer independently crawls over the Internet, parses and indexes web pages, and stores indexing results in a common database (called an index) that is shared with other YaCy-peers using P2P networking principles. It's a free search engine that everyone can use to create a search portal for their intranet and to help them search the public Internet clearly.
Compared to semi-distributed search engines, the YaCy network has a decentralized architecture. All YaCy-peers are the same and no central server exists. It can run in a crawl mode or as a local proxy server, indexing web pages visited by the person running YaCy on your computer. Various mechanisms are provided to protect user privacy. Access to search functions is through a locally running web server, which provides a search box for entering search terms and returns search results in a format similar to other popular search engines.
YaCy is available on Windows, Mac and Linux. YaCy was created in 2003 by Michael Christen.
The YaCy search engine is based on four elements:
Crawler
A search engine that scans web pages and analyzes their content.
Indexer
Creates a reverse word index (RWI), that is, each RWI word has its list of relevant URLs and ranking information. Words are saved in the form of word hashes.
Search and Administration Interface
Made as a web interface provided by a local HTTP servlet with the servlet engine.
Data storage
Used to store the reverse word index database using a distributed hash table.
Search Engine Technology
Gigablast
Gigablast is an open source directory and search engine. Founded in 2000, it is an independent Albuquerque, New Mexico-based web crawler engine developed and maintained by Matt Wells, a former Infoseek employee and graduate of New Mexico Tech.
Search engine source code is written in the C and C ++ programming languages. It was released as open source software under the Apache version 2 license in July 2013. In 2015 Gigablast claimed to have indexed over 12 billion web pages and received billions of queries per month.
Gigablast has provided and provides search results for other companies such as Ixquick, Clusty, Zuula, Snap, Blingo and Internet Archive.
History
Matt Wells worked for Infoseek search engine until leaving in 1999 to start work on what would become Gigablast, coding everything from scratch in C ++. It was originally designed to index up to 200 billion web pages. Gigablast went live on July 21, 2002.
Features
Gigablast supports a number of specialized searches and Boolean algebra operators. It also supports a related concepts feature called Giga Bits and a blog search feature.
A feature called Gigabits provides relevant information beyond what the user is searching for.
Gigablast also claims to be, as of 2010, the "leader" clean energy search engine with 90 percent of its power coming from wind power.
Dogpile
Dogpile is a World Wide Web search engine that searches results from Google, Yahoo!, Yandex, Bing and results from other popular search engines, including audio and video content providers like Yahoo!
Dogpile went live in November 1996. The site was created and developed by Aaron Flin, who was frustrated with the varying results of existing indexes and intended to make Dogpile query multiple indexes for the best search results. Originally, it provided Yahoo! (directory), Lycos (directory A2Z), Excite (directory Excite Guide), WebCrawler, Infoseek, AltaVista, HotBot, WhatUseek (directory) and World Wide Web Worm. He naturally made comparisons with MetaCrawler, a multi-search engine threaded entity that existed before, but Dogpile was more advanced, and could also search Usenet (from sources including DejaNews) and FTP (via Filez and other indexes).
In August 1999, Dogpile was acquired by Go2net, which was already operating MetaCrawler. Go2net was then acquired by InfoSpace in July 2000 for $4 billion. Dogpile received a redesign of its interface for the first time in December 2000.
The Dogpile search engine won the JD Power and Associates Award for Best Residential Online Search Service in 2006 and 2007.
In August 2008, Dogpile and Petfinder agreed to a research partnership.
In November 2008, Dogpile launched the Search and Rescue program, which donates money to animal-related charities. The program also helps people find help for animals in need. By early December 2008, people using the Dogpile search engine had raised $ 100,000 for Dogpile's Search and Rescue program.
In July 2016, Blucora announced the sale of its InfoSpace business to OpenMail for $45 million in cash, placing Dogpile under the ownership of OpenMail. OpenMail was later renamed System1.
Features
SearX
SearX (/ s3:rks /) is a free metadata engine, available under the GNU Affero General Public License version 3 license, to protect the privacy of its users. To this end, Searx does not share users' IP addresses or search history with the search engines from which it collects results. Tracking cookies served by search engines are blocked, preventing modification of results based on user profiles. By default, Searx queries are sent via HTTP POST to prevent user query keywords from appearing in Web server logs. Searx was inspired by the Seeks project, although it does not implement peer user result ranking. -to-peer from Seeks.
Each search result is provided as a direct link to their site, rather than a crawled redirect link used by Google. In addition, when available, these deep links are accompanied by "cached" and / or "proxy" links that allow you to view result pages without actually visiting the sites in question. "Cached" links point to saved versions of a page on archive.org, while "proxy" links allow you to view the current active page through a Searx-based web proxy. In addition to general search, the engine also features guides for searching on specific domains: files, images, IT, maps, music, news, science, social media, and videos.
Along with the best known instance on searx.me, Searx also features dozens of user-run instances under their own URLs, some of which are available as hidden Tor services. "Meta-searx" sites refer to a different random instance on each search. A public API is available for Searx, as well as for Firefox search provider plugins, and for an Android app.
Why use Searx?
Technical Details - How does it work?
Searx is a meta search engine, inspired by the Seeks project. It provides basic privacy by blending its queries with searches on other platforms without storing survey data. Queries are made using a POST request in all browsers (except chrome *). Therefore, they do not appear in their logs or in your URL history. For Chrome * users, there is one exception, Searx uses the search bar to make GET requests.
Searx can be added to your browser's search bar; Additionally, it can be set as the default search engine.
Searx was created by Adam Tauber.
Gibiru
Following the DuckDuckGo search engines and Startpage (the former ixquick), Gibiru is the latest addition to the slowly growing group of anonymous search engines, and all promise to put privacy before their profits. Like Startpage, one of Gibiru's advantages is that you can use it to privately search Google's own databases, offering all the benefits of Google search, but without any privacy risks.
Gibiru founder and CEO Steve Marshall announced in a press release that his service is exactly what Google was 10 years ago. This comment exactly mimics DuckDuckGo CEO Weinberg's statement when he launched his website. Like DuckDuckGo and Startpage, Gibiru claims to allow its users to search privately, claiming that the site does not use your IP address or cookie data when returning search results.
Escape the Google filter bubble
The search engine used by Gibiru apparently follows a modified Google algorithm that allows you to get the search results you are used to from Google while still hiding your identity from Google's servers. If true, your searches will not be modified according to who you are and you will be free from the so-called "Google filter bubble". Gibiru was founded in 2009 by Steve Marshall.
Well, here we end the first part of recommendations for alternatives to Google services and products. I scanned the search engines one by one and was impressed by Gigablast, Dogpile and Gibiru, very fast and very relevant results, which is important now that Google is censoring results.
So continue with us next month, when I will continue this series, and, let's go, De-Googling ourselves, a little bit every day. I seldom use Google's search engine myself. Others have far more "out of the box" results.
Casual Python, Part 7
Repo Review: PhotoFlare
by CgBoy
This month I'm taking a quick look at PhotoFlare, a simple, but powerful image editor intended to be very quick and easy to use. Some of its features include color levels adjustment, image filters, batch image processing, automatic cropping, and many more. It currently does not support any RAW image formats, or image layers, though.
The interface is well designed, making the program very easy to use, and the layout is also customizable. Except for a few tools, most of PhotoFlare's image editing features can be easily accessed from the top and side toolbars.
The toolbar on the side contains the color selector and some of the basic image manipulation tools. You have access to the pointer tool for making selections, a color picker, the magic wand tool for making automated selections, a line drawing tool, a paint fill bucket, a spray paint tool, two kinds of paintbrushes, a cloning tool, a blur tool, an eraser, and a smudge tool.
The toolbars at the top contain the buttons for adjusting the brightness, contrast, saturation, gamma, hue, and image size and orientation. Text can be inserted, and a number of filters, such as grayscale, sepia, noise reduction, softening, and sharpening, can also be applied from the toolbar. All the rest of PhotoFlare's filters can be accessed from the Filter menu.
PhotoFlare has a useful tool for batch image processing, allowing you to apply filters and transformations to multiple images at once, and then save them to an output folder in the format of your choice. You can set it to adjust the image size, levels (brightness, contrast, saturation, and gamma), image orientation, and you can apply any of the available filters.
Summary
If all you need is a simple program for editing and adjusting your images, I think PhotoFlare is an excellent choice. I did run into a few bugs occasionally, but for the most part it worked well enough. GIMP is obviously still a better option if you need something more advanced, but PhotoFlare is much simpler and easier to use.
PCLinuxOS Family Member Spotlight: MarekTux
As told to YouCanToo
What is your name/username?
Markus Henseleit/MarekTux
How old are you?
44 years old.
Are you married, single?
Married to a Filipina, but she is still in the Philippines, so currently I'm living alone.
How about Kids, Grandkids (names and ages)?
Nope.
Do you have pets, what is your favorite?
Nope.
Are you retired, still working and if working, what do you do?
Still working. After a brief period of unemployment, I'm currently occupied as an employee in the IT department of a small company dealing with digital forms and digitalization in general,
Where do you call home? What is it like? IE: weather, scenery
My home is where I hang my hat - wait, that's a hatstand...
Currently here in Berlin, Germany, Europe, Sol III
Berlin
Berlin
Brandenburg Gate
Where did you go to school and what is your education level?
I went to school here in Germany, Northern Germany to be exact. I reached the equivalent as graduating from high school.
What kind of things you like doing? hobbies, travel, fishing, camping?
I enjoy all kind of history, I often go to museums and read or hear audio books in a rather large field (mystery, crime, science-fiction, fantasy...), preferably in English, but also some in German.
Why and when did you start using Linux?
Along time ago (in a galaxy far, far away) - actually, my last Windows at home was Windows 2000... Eventually, after a long period of distro-hopping, I stuck to PCLinuxOS, first for the 32-bit edition - and I haven't regretted it.
What specific equipment do currently use with PCLinuxOS?
On my desktop.
Do you feel that your use of Linux influences the reactions you receive from your computer peers or family? If so, how?
Not too much, to be honest. I've no intention any more to persuade them to another OS, even if most things are easier.
What would you like to see happen within PCLinuxOS that would make it a better place. What are your feelings?
Great idea. But honestly, I cannot think of anything that is truly lacking within PCLinuxOS.
PCLinuxOS Family Member Spotlight is an exclusive, monthly column by YouCanToo, featuring PCLinuxOS forum member. This column will allow "the rest of us" to get to know our forum family members better, and will give those featured an opportunity to share their PCLinuxOS story with the rest of the world.
If you would like to be featured in PCLinuxOS Family Member Spotlight, please send a private message to youcantoo, parnote or Meemaw in the PCLinuxOS forum expressing your interest.
Short Topix: Vulnerability Discovered Masquerading As Gnome Extension
by Paul Arnote (parnote)
Mozilla, Firefox Branded "Internet Villains"
On July 2, 2019, the U.K.'s Internet Service Providers' Association (ISPA) announced their candidates for Internet Hero of the Year, as well as their candidates for Internet Villain of the Year. Amazingly, Mozilla/Firefox was listed among the "villains." Here is a snippet from their announcement:
Mozilla -- for their proposed approach to introduce DNS-over-HTTPS in such a way as to bypass UK filtering obligations and parental controls, undermining internet safety standards in the UK.
So, what is DNS-over-HTTPS? Well, according to Wikipedia, DNS over HTTPS (DoH) is a protocol for performing remote Domain Name System (DNS) resolution via the HTTPS protocol. A goal of the method is to increase user privacy and security by preventing eavesdropping and manipulation of DNS data by man-in-the-middle attacks.
Typically, DNS information is passed between computers in an unencrypted state. Because of this, users can be more easily tracked, and their actions monitored. According to a TechCrunch article, under the law in the U.K., websites can be blocked for facilitating the infringement of copyrighted or trademarked material, or if they are deemed to contain terrorist material or child abuse imagery.
By encrypting DNS queries, it's claimed that it will make it more difficult for internet providers to filter their subscribers' internet access The ISPA isn't alone. U.K. spy agency GCHQ (the U.S. NSA's U.K. brethren) and the Internet Watch Foundation, which maintains the U.K.'s internet blocklist, have criticized the move to roll out encrypted DNS features to the browser.
Really? This is what you get when you have ISPs caught between protecting user privacy and policing users to remain in compliance with heavy handed government regulations. Any reasonable person would expect that user privacy would be front and center. But then again, if they do not remain in compliance with the heavy handed government regulations, they won't be in business any longer either. So, in effect, it is a Catch-22, a complete "damned-if-you-do, damned-if-you-don't" situation.
Mozilla isn't the first to implement DoH. Cloudflare has been offering DoH since April, 2018 with their 1.1.1.1 DNS service. We first told you about it here, in the May, 2018 issue of The PCLinuxOS Magazine. Millions of users are currently waiting for Cloudflare to roll out its recently announced forthcoming VPN service, so there is little doubt that users are clamoring for improved internet security.
More Than 1,300 Android Apps Circumvent Permissions
According to a multinational research document (PDF) from the International Computer Science Institute, called "50 Ways to Leak Your Data: An Exploration of Apps' Circumvention of the Android Permissions System," 1,325 Android apps circumvent the permissions granted to them by users. They looked at 88,000 popular apps from the Google Play store, across all categories. You would think that once a user denies or grants specific permissions to an app, that would be the end of the discussion.
But ... Noooooo! Many of the 1,325 apps either continued on as if the user never denied permissions (such as access to location data, WiFi, contacts, camera, etc.), or just piggy-backed their data extraction from other legitimate apps that were given permissions. The information was presented to the attendees of the Federal Trade Commission's PrivacyCon in late June, 2019, after being reported to both Google and the FTC in September, 2018.
One app that was used as an example in the report was the Shutterfly app. Even after permissions for location sharing were denied, GPS coordinates for individual photos were still uploaded to Shutterfly's servers, and stored there. You will be in for quite a surprise if you look at the EXIF data from photos taken with your phone's camera.
From the report:
We observed that the Shutterfly app (com.shutterfly) sends precise geolocation data to its own server (apcmobile.thislife.com) without holding a location permission. Instead, it sent photo metadata from the photo library, which included the phone's precise location in its exchangeable image file format (EXIF) data. The app actually processed the image file: it parsed the EXIF metadata--including location--into a JSON object with labelled latitude and longitude fields and transmitted it to their server.
While this app may not be intending to circumvent the permission system, this technique can be exploited by a malicious actor to gain access to the user's location. Whenever a new picture is taken by the user with geolocation enabled, any app with read access to the photo library (i.e., READ_EXTERNAL_STORAGE) can learn the user's precise location when said picture was taken. Furthermore, it also allows obtaining historical geolocation fixes with timestamps from the user, which could later be used to infer sensitive information about that user.
Yessiree. Encoded within each photo taken with your cellphone's camera is the exact GPS coordinates within the EXIF data that is stored in the JPG files detailing exactly where that particular photo was shot. It won't show up if you just look with the EXIV2 command line tool, which seems to promote itself as an enhanced EXIF tool. You must look with the EXIF tool, specifically. Install the EXIF tool from the PCLinuxOS repository, and (from a normal command line), run exif -m yourphoto.jpg. You're likely to be as surprised as I was. To be totally honest, I had never really given it any thought before that my photos taken with my cellphone's camera contained geolocation information that virtually anyone could access.
But the Shutterfly app wasn't just guilty of uploading the EXIF information that's stored in the header of each JPG file. Nope. The Shutterfly app specifically extracted the GPS data (along with other EXIF data) and uploaded a JSON object to the Shutterfly servers. While Shutterfly isn't using this information for nefarious or evil purposes, it perfectly illustrates a vulnerability that most users won't even have a cursory or glancing thought about.
Google has responded to the report, and said that these issues will be addressed (at the earliest) in Android Q, which is due to be released later this year.
Vulnerability Discovered Masquerading As Gnome Extension
CAUTION! There is a new vulnerability for Linux masquerading as a GNOME shell extension. Fortunately for PCLinuxOS users, the incidence should be miniscule, due to the fact that GNOME isn't one of the desktops offered on PCLinuxOS. I first saw this reported on BleepingComputer.com, stumbling upon subsequent articles on OfficialHacker.com and TheHackerNews.com.
What makes things worse is that it is NOT detected by any of the major virus scanners. Called EvilGnome, it's installed as a self-extracting archive, camouflaging itself as a GNOME shell extension. Once installed, it sets up cron jobs that take screenshots of the user's computer, captures audio from the user's microphone, and looks for newly created files on the user's computer. It then sends that gathered data to the owner's command-and-control server. It can also ping the owner's server, and download and execute additional payloads. The malware also contains an uncompleted and yet-to-be-implemented keylogger.
EvilGnome has been linked back to a Russian threat group, known as Gamaredon Group. They are an active and persistent threat group that has been around since 2013.
Since it has thus far evaded the major virus checkers, just how do you know if you've been compromised? Fortunately, that's fairly easy. Take a look in ~/.cache/gnome-software/ gnome-shell-extensions, and look for the "gnome-shell-ext" executable. If you don't find it, then you're in the clear. The malware stores its collected data in the ~/.cache/gnome- software/gnome-shell-extensions/tmp/ folder on infected Linux computers. EvilGnome connects to its command-and-control servers via SSH, over port 3436.
This newest exploit perfectly makes the case for how dangerous it is to download and install software from outside of the official PCLinuxOS repository. By sticking to the official offerings in the PCLinuxOS repository, you virtually eliminate the possibility of becoming one of its victims.
LightSail 2 Set To Prove Value Of Solar Sails
The Planetary Society launched a small cubesat on June 25, 2019, from a Falcon Heavy rocket that launched from Kennedy Space Center in Florida. The satellite was deployed July 2, 2019 from another satellite that was designed by Georgia Tech students. The solar sail was successfully deployed on July 23, 2019.
Roughly thirty days after deployment of the solar sail, the mission plan is to raise the satellite's orbit using the solar sail as the only propulsion. Solar sails work by using only the impact of the Sun's photons upon the surface of the extended sail material.
LightSail is a crowd-funded venture (raising over $1 million with a KickStarter campaign) that sets out to prove the value and usefulness of using solar sails as the sole propulsion source of small cubesat satellites. The Planetary Society has advocated for the use of solar sails for decades. They found their first practical success in 2005 with the launch of Cosmos 1, a solar sailing spacecraft. However, it was lost due to a rocket failure. In 2015, LightSail 1 successfully completed its test flight, paving the way for this current endeavor.
Anyone with an internet connection can follow along with LightSail 2's progress by visiting its Mission Control Center. The Planetary Society, under the leadership of CEO Bill Nye (yes, THAT Bill Nye, of television fame from the Bill Nye The Science Guy fame), is the world's largest and most influential non-profit space organization. The organization is supported by over 50,000 members in over 100 countries, and by hundreds of volunteers around the world.
Mad Magazine Closes Shop After 67 Years
After 67 years, MAD Magazine is essentially closing down. Well, not completely, but at least in a very significant way compared to how we have come to know them. Alfred E. Neuman and company's monthly satirical review will sell its last monthly magazine on newsstands in August, 2019.
Started in 1952, the magazine features irreverent, satirical humor targeting current events and societal trends. Nothing is or was sacred. They even often poked fun at themselves. Along the way, it has wielded significant influence in helping either fuel the current debate(s), or shaping the debate in a different light. But, in today's culture where runaway, rampant political correctness rules the discussions, it seems many people can't take a joke or see the humor in many topics of the day.
Starting with 2019's issue 10, it will only be available in comic book shops, and mailed to subscribers. Starting with 2019's issue 11, there will no longer be any new content, except for end-of-the-year specials. From issue 11 onward, they will only feature previously published content, drawn from its massive vault of material gathered from the past 67 years. DC Comics, however, will continue to publish MAD books and special collections.
Although it started out as a comic book, it quickly changed its format to a bimonthly magazine. Its covers, featuring Alfred E. Neuman with his gap-toothed smile, were eagerly anticipated by its fans. It was very influential for successive generations of comedians, writers, artists and performers.
With the state of the world being what it is, we need the irreverent and satirical humor of MAD Magazine more than ever. It's saddening that such a publication will be closing up shop. We need you A. E. Neuman, more than ever!
Are Notifications On Google Maps Driving You Crazy On Your Android Device?
If you use Google Maps on iOS, you won't have this problem; for some reason, iOS users are immune from this problem. But, if you use Google Maps on an Android device, this problem is enough to DRIVE. YOU. CRAZY. There are 54 different notifications for Google Maps, and by default, they are ALL turned on. Oh, yay! What a treat for users of Google's own OS!
These notifications from Google Maps can quickly overwhelm users. At minimum, they crowd out more important notifications, becoming more of an annoyance than being helpful.
You could tap on the hamburger menu at the left upper corner of the Google Maps window, select Settings, then Notifications, and then begin to plow through all of the notifications that Google Maps has turned on. If you choose this route (or forced to because of the version of Android you use), be prepared for an arduous journey through "notification hell." Many of the notifications are obscurely described, so you may never be sure if they are turning off something helpful, annoying, or that doesn't even apply to you and your life. You'd probably have better odds playing craps at the local casino.
But, if you use Android 9 Pie, there is an easier and faster way to turn off whole groups of notifications. By turning off whole groups of notifications, you don't have to wade through each and every one of the 54 different notifications.
To accomplish this, follow the steps below.
First, "long press" the Google Maps icon.
Second, in the little window that pops up, click on the "information" icon near the top. It looks like an "i" with a circle around it, a lot like a copyright or trademark symbol. This will take you directly to the "app info" screen.
Third, tap on "Notifications" in the "app info" screen.
Fourth, and lastly, you should find all of the notifications divided up into categories. This makes it much easier to turn off entire groups of notifications that you don't want to be bothered with.
For example, I never use public transportation, so that whole group of notifications was a no-brainer for me. Another one for me was Google Maps telling me, every morning when I go to work, how many minutes it will take to get there. Uhm ... that never, ever changes, and it's just a nuisance notification. So those types also got turned off, too.
Now, I'm hoping that I'm feeling a lot less "love" from Google Maps. I've tested this, and it does work (I'm running Android 9 Pie, on a Google Pixel 3 phone). The nice thing about using this method is that if you turn off notifications that you find useful, you can repeat the steps above to turn them back on.
The Ruby Programming Language: Blocks, Modules and Other Interesting Things
ms_meme's Nook: It's Linux Time
PCLinuxOS Recipe Corner Bonus
Mediterranean Shrimp Linguine
Ingredients
4 cups Zucchini noodles
2 pounds uncooked medium shrimp, peeled and deveined
1 medium onion, chopped
6 tablespoons olive oil
4 garlic cloves, minced
1 cup chopped roasted sweet red peppers
2 cans (2-1/4 ounces each) sliced ripe olives, drained
1/2 cup minced fresh parsley
1/2 cup white wine or chicken broth
1/2 teaspoon crushed red pepper flakes
1/2 teaspoon kosher salt
1/2 teaspoon dried oregano
1/2 teaspoon pepper
3/4 cup crumbled feta cheese
2 tablespoons lemon juice
Directions
Cook Zucchini noodles in boiling water for 3 minutes, drain and rinse in cold water to stop cooking, reserve 1/2 cup cooking water.
In a large skillet, saute shrimp and onion in oil until shrimp turns pink. Add garlic; cook 1 minute longer. Stir in the red peppers, olives, parsley, wine, pepper flakes, salt, oregano and pepper. Reduce heat.
Add Zucchini noodles and reserved water to the skillet. Stir in cheese and lemon juice; cook and stir until cheese is melted.
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